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INTRODUCTION
Welcome to the Quick Part Series - Acoustic Amplifier tutorial. In this course you will explore how to
design andmachine an acoustic amplifier that you can use to enjoy music from your smartphone.
Starting with the instructions provided with this tutorial, you will use wireframe and solid CAD tools to
create the geometry for the model. Using a variety of rough and finish toolpaths, you will program
and verify the model to ensure it can be cut successfully. Finally, you will post out your toolpaths to
generate NC code and cut the part.

This tutorial will provide you with the basic techniques needed to create the acoustic amplifier. From
there, you can explore Mastercamand challenge yourself to make some other interesting projects.

Tutorial Goals
l Understand basic wireframe and solidmodel design tools and how they can be used to create a
complex solidmodel

l Learn how tomirror geometry to create a symmetrical design

l Learn how to programapart for a router using standard and dynamic toolpaths

l Identify safe hold-down options for router work, such as tabs and woodscrews, or a vacuum
table

l Verify operations

NOTE
Screen colors in the tutorial pictures were modified to enhance image quality; they may not
match your Mastercam settings or the tutorial results. These color differences do not
affect the lesson or your results.

General Tutorial Requirements
All MastercamProject Based Learning tutorials have the following general requirements:

l Youmust be comfortable using the Windows® operating system.

l Each lesson in the tutorial builds on the mastery of the preceding lesson's skills. We recommend
that you complete them in order.

l Additional filesmay accompany a tutorial. Unless the tutorial provides specific instructions on
where to place these files, store them in a folder that can be accessed from the Mastercam
2020 workstation, either with the tutorial or in any location that you prefer.

l All Mastercam tutorials require you to configure Mastercam to work in a default Metric or Inch
configuration. The tutorial provides instructions for loading the appropriate configuration file.
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Starting Mastercam Quick Part
NOTE
The Quick Part Series tutorials assume you are using an Educational license and the
MastercamQuick Part interface. You do not need to install the Quick Part interface to
complete this tutorial. The Quick Part interface is only available to Educational licenses.

The Quick Part interface is a simplified version of the Mastercam interface, hiding some of the more
complex functions. Upon startingMastercam, the following prompt displays:

Select Quick Part. To return to the standardMastercam interface, you need to close and re-open
Mastercam. Then select Standard.

Mastercam Part Files
The provided part files are in .mcam format. This allows both Industrial and Educational license users to
open the part files. Files saved with an Educational license have an .emcam file extension. This does not
affect the completion of the tutorial.

Material Requirements
The followingmaterials are recommended tomachine the part we use in this tutorial with the
suggestedmachine definition, feeds and speeds, and tooling. Using different materials will affect the
tooling and toolpath settings.

l Solid wood, 20 inches x 8 inches x 1.25 inches

l 2 Wood dowels, 3 inches x 0.5 inch (diameter)

8
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Machine and Tool Requirements
WARNING
This tutorial is completed using a specificmachine andmaterial. The settings, tooling, feeds,
and speeds recommended in this tutorial are based on the use of this equipment, as well as
the material to be machined. Your resultsmay differ, based on the machine, its age and
prior utilization, and tooling used, as well as the material selected for machining.

This tutorial recommends the following:

l A standard router, preferably with a vacuum table. The cutting surface should be large enough
to accommodate the workpiece and any required fixtures.

If you do not use a vacuum table, you will need to program your toolpaths to accommodate for
any hardware, such as clamps or screws, that you use to hold down your stock.

l 3/8 in. Flat EndMill

Accessing the Home Learning Edition
The MastercamHome Learning Edition (HLE) is a free version of Mastercam that lets you practice
design and programming skills without having a full Mastercam license. The HLE software lets you save
your Mastercam files, but it will not post code.

The HLE is available for free at the following location: https://signup.mastercam.com/demo-hle.

Quick Part Series - Acoustic Amplifier—Introduction
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CHAPTER 1

CREATING THE ACOUSTIC AMPLIFIER GEOMETRY
In this chapter you will use the design (CAD) functions of Mastercam to create the acoustic amplifier.
You will use wireframe, transform, and solid functions to produce the overall acoustic amplifier design.

Goals

l Understand Z depth and construction planes.

l Explore wireframe, solid, and transform functions to create geometry.

l Use Trim to Entities and Divide functions to modify geometry.

Exercise 1: Configuring Mastercam
In this exercise, you openMastercamand set your system configuration to be inch.

1. Start Mastercamusing your preferredmethod:

a. Double-click Mastercam's desktop icon.

OR

b. LaunchMastercam from the Windows Start menu.

2. Select the default inch configuration file:

a. Click the File tab.

b. Choose Configuration fromMastercam's Backstage View to open the System
Configuration dialog box.

c. Choose ...\mcamx.config <Inch> from the Current drop-down list.

d. ClickOK.
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Exercise 2: Creating the Base Shape
In this exercise you will create the base rectangular shape of the acoustic amplifier.

1. Select Show Axes on the View tab.

NOTE
You can also press [F9] to display the axes.

2. Select Rectangle on theWireframe tab.

The Rectangle function panel displays.

3. Set the following parameters:

a. Enter 8.0 forWidth.

b. Enter 6.0 for Height.

c. Ensure that Anchor to center is deselected.

12
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4. Select the origin in the graphics window to place the rectangle.

5. ClickOK in the Rectangle function panel.

6. Right-click in the graphics window and select Fit. Right-click again and select Isometric (WCS).
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7. On the Solids tab, select Extrude.

The Chaining dialog box displays.

8. Select the rectangle.

9. ClickOK in the Chaining dialog box.

The Solid Extrude function panel displays.
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10. Set the following parameters:

a. Enter Body for Name.

b. Enter 1.25 for Distance. This is the thickness of the part.

NOTE
If the rectangle is not extruding up from the base, as shown below, select
Reverse All to reverse the direction of the extrusion.

11. ClickOK in the function panel.

Quick Part Series - Acoustic Amplifier—1: Creating the Acoustic Amplifier Geometry



12. Save your file as Amplifier-XXX, where XXX represents your initials.

Exercise 3: Creating the Sound Channel Geometry
In this exercise you will create the sound channel geometry using wireframe geometry. You will create
the line geometry first, then use trimming functions to create the base shape of the channel. In the
following exercise, you will use the trimming functions to create the base shape of the channel.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select the Home tab.

16
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3. Set the following:

a. Select 3D in the Attributes group. The icon changes to 2D.

b. Enter 1.25 for Set Z Depth.

NOTE
The Z Depth and 2D/3D Construction plane value can also be changed on
the Status Bar.

4. Right-click in the graphics window and select Top (WCS).

5. Select Line Endpoints on theWireframe tab.

The Line Endpoints function panel displays.
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6. Set Type to Vertical.

7. Click in the graphics window above the solid rectangle and drag down to create a vertical line that
passes over the part.

8. Enter 1.0 for Axis Offset. Press [Enter].

18
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9. Click in the graphics window and create another vertical line with an Axis Offset of 3.0. Press
[Enter].

10. Set Type toHorizontal.
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11. Click in the graphics window to the left of the solid rectangle and create a horizontal line that
passes over the part.

The line can be in any location over the rectangle. It will be moved in the next step.

12. Enter 3.25 for Axis Offset. Press [Enter].

20
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13. Create twomore horizontal lines. One with an Axis Offset of 4.25 and then another with 5.25.

There should nowbe a total of two vertical lines and three horizontal lines.

14. ClickOK in the Line Endpoints function panel. You will trim the lines in the next exercise.

15. Save your file.

Exercise 4: Trimming the Sound Channel Geometry
In this exercise you will trim and add fillets the geometry created in the previous exercise to create a
smoother channel shape.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select Trim to Entities on theWirefame tab.

The Trim to Entities function panel displays.

Quick Part Series - Acoustic Amplifier—1: Creating the Acoustic Amplifier Geometry



3. SetMethod to Trim 2 entities.

Line entities will be trimmed to achieve the following shape:

4. Select the lines in the order shown in the following image for the first trim.

Mastercam’s Trim to Entities function trims, breaks, and extends entities selected in the
graphics window. Auto-preview displays the results of the selected function as youmove the
mouse over the final entity selection. A solid line represents what will be created. A dashed line
represents what will be removed.

22
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5. Select the lines in the order shown in the following image for the second trim.

6. Select the lines in the order shown in the following image for the third trim.

7. Select the lines in the order shown in the following image for the fourth trim.
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8. Select the lines in the order shown in the following image for the fifth trim.

9. ClickOK in the Trim to Entities function panel. Your part shouldmatch the image below.

10. Select Circle Center Point on theWireframe tab.

The Circle Center Point function panel displays.
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11. Enter 1.0 for Diameter and click the Lock icon next toDiameter.

12. Select the midpoint of the two lines shown below.

13. ClickOK in the Circle Center Point function panel.

14. Select Divide on theWireframe tab.

The Divide function panel displays.

15. Select the two center lines of the created arcs.
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16. Select the following arcs.

17. ClickOK in the Divide function panel.

18. Save your file.

Exercise 5: Offsetting the Sound Channel Geometry
In this exercise, you will offset the geometry created from the previous exercises.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select Offset, Chains from theWireframe tab.

The Chaining dialog box displays.
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3. Select the line geometry as shown below.

4. ClickOK in the Chaining dialog box.

5. Click in the graphics window above the top line to indicate the offset direction.

The Offset Chains function panel is now active.
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6. Set the following parameters:

a. SetMethod toMove.

b. Enter 0.25 for Distance.

c. Set Direction to Both sides.

7. ClickOK in the Offset Chains function panel.

8. Right-click in the graphics window and select Clear Colors.

28

Quick Part Series - Acoustic Amplifier—1: Creating the Acoustic Amplifier Geometry



29

9. Save your file.

Exercise 6: Creating the Amplifier Channel Geometry
In this exercise, you will create the amplifier channel geometry that feeds from the sound channel
geometry made from the previous exercises.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam..

2. Select Line Endpoints on theWireframe tab.

The Line Endpoints function panel displays.
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3. Set Type to Freeform.

4. Hold down the [Shift] key and select the origin in the graphics window.

The Dynamic gnomon displays.

Select the X axis arrow.
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5. Enter 0.25 and press [Enter].

6. Press [Enter] twice.

7. Click in the graphics window above the solid rectangle to create the line.

8. Enter 70.0 for Angle.
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9. Hold down the [Shift] key and select the midpoint of the bottom line in the graphics window.

10. Select the X axis arrow.

11. Enter -0.25 and press [Enter].

12. Press [Enter] twice.
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13. Click in the graphics window above the solid rectangle to create the line.

14. Enter 110.0 for Angle.

15. ClickOK in the Line Endpoints function panel.

16. Select Fillet Entities on theWireframe tab.

The Fillet Entities function panel displays.
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17. Enter 0.2 for Radius.

18. Select the lines in the order shown in the following image.

19. ClickOK and Create New Operation in the Fillet Entities function panel.

20. Enter 1.25 for Radius.
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21. Select the lines in the order shown in the following image.

22. ClickOK in the Fillet Entities function panel.

23. Save your file.
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Exercise 7: Mirroring the Geometry
In this exercise, you will use the Mirror function to mirror the created geometry.

1.1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select Line Endpoints on theWireframe tab.

The Line Endpoints function panel displays.

3. Set Type to Vertical.

36
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4. Select the midpoint of the top line and select the midpoint of the bottom line to create a line
across the part.

5. ClickOK in the Line Endpoints function panel.

6. SelectMirror on the Transform tab.

TheMirror function panel displays.
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7. Hold down the [Shift] key and select the two lines you have created.

8. Press [Enter].

TheMirror function panel is now active.

NOTE
You can also select End Selection to finish selecting geometry instead of pressing
[Enter].

NOTE
When you first enter in theMirror function, the entities will mirror about the X axis
by default. It will be corrected in the next steps.

38

Quick Part Series - Acoustic Amplifier—1: Creating the Acoustic Amplifier Geometry



39

9. Set Axis to Vector and click Select Vector.

10. Select the vertical line as the mirror axis.
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11. ClickOK in theMirror function panel.

12. Select Trim to Entities on theWireframe tab.

The Trim to Entities function panel displays.

13. SetMethod to Trim 1 entity.
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14. Select the top line and then the vertical axis line as shown in the following image.

15. Repeat this process for the other three lines.

16. ClickOK in the Trim to Entities function panel.

17. Right-click in the graphics window and select Clear Colors. Then, select Isometric (WCS).
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18. Save your file.

Exercise 8: Extruding the Geometry
In this exercise, you will extrude the geometry that was created andmirrored in the previous
exercises.

1.1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select Line Endpoints on theWireframe tab.

The Line Endpoints function panel displays.

3. Set Type toHorizontal.
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4. Select the following endpoints to close the open pockets.

NOTE
Ensure that you are selecting the endpoint of the lines. Wait for the green endpoint
icon before clicking.

You can also press [Alt+S] to show the part as wireframe to view the linesmore
clearly.

5. ClickOK in the Line Endpoints function panel.

6. Select Extrude on the Solids tab.

The Chaining dialog box displays.
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7. Select the chain as shown below.

NOTE
Ensure that you see a green arrow on the chain you selected. If you see a red arrow,
then the chain is not closed and youwill not be able to extrude the chain.

8. ClickOK in the Chaining dialog box.

The Solid Extrude function panel displays.

9. Set the following parameters:

a. Enter Channel for Name.

b. Set Type to Cut body.

c. Enter 1.0 for Distance.
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NOTE
If the channel is not extruding down to cut the part select Reverse All to reverse the
direction of the extrusion chain.

10. ClickOK in the Solid Extrude function panel.

11. Save your file.
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Exercise 9: Creating the Index Holes
In this exercise, you will create the index holes used to combine the top and bottompieces of the
acoustic amplifier.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Right-click in the graphics window and select Top (WCS).

3. Select Circle Center Point on theWireframe tab.

The Circle Center Point function panel displays.

4. Enter 0.504 for Diameter.
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5. Create the arc at the center of the origin.

6. ClickOK in the Circle Center Point function panel.

7. Select Translate on the Transform tab.

8. Select the circle and press [Enter].

The Translate function panel becomes active.
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9. Set the following parameters:

a. SetMethod toMove.

b. Enter 0.75 for X.

c. Enter 3.25 for Y.

10. ClickOK in the Translate function panel.

11. SelectMirror on the Transform tab.

12. Select the circle and press [Enter].

TheMirror function panel is now active.
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13. Ensure that Axis is set to Vector. Click Select Vector to return to the graphics window.

14. Select the vertical line shown below.

15. ClickOK in theMirror function panel.

Quick Part Series - Acoustic Amplifier—1: Creating the Acoustic Amplifier Geometry



16. Right-click in the graphics window and select Fit. Then select Isometric (WCS).

17. Select Extrude on the Solids tab.

The Chaining dialog box displays.

18. Select the two wireframe circles you just created.

19. ClickOK in the Chaining dialog box.

The Solid Extrude function panel displays.
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20. Set the following parameters:

a. Enter Index Holes for Name.

b. Ensure that Type is set to Cut Body.

c. Enter 0.5 for Distance.

NOTE
If the index holes are not extruding down to cut the part select Reverse All
to reverse the direction of the extrusion chains.

21. ClickOK in the Solid Extrude function panel.

22. Right-click in the graphics window and select Clear Colors.
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23. Save your file.
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Exercise 10: Creating the Phone Slot Geometry
In this exercise, you will create the geometry necessary for the phone slot. For this exercise, the
dimensions given are for a Samsung Galaxy® 9 phone.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. In the Status Bar at the bottomof the Mastercamwindow, click the value next to Z and enter
0.25. Press [Enter] to apply the value.

3. Right-click in the graphics window and select Top (WCS).
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4. Select the vertical line used as the vector line.

5. Select Delete Entities on the Home tab or press the [Delete] key to remove the selected line
from the part file.

The part displays as shown below.
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6. Select Rectangle, Rectangular Shapes on theWireframe tab.

The Rectangular Shapes function panel displays.

7. Enter the following parameters:

a. Set Type toObround.

b. Set Origin to the bottommiddle point.

c. Enter 3.75 forWidth.

d. Enter 0.6 for Height.
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8. Select the endpoint of the line segment as shown below.

9. ClickOK in the Rectangular Shapes function panel.

10. Press [Alt+S] to display the part only as wireframe.

11. Save your file.
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Exercise 11: Extruding the Phone Slot Geometry
In this exercise, you will extrude the phone slot geometry created in the previous exercises.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select Extrude on the Solids tab.

The Chaining dialog box displays.

3. Select the obround shape you just created as shown below.

NOTE
It may be easier to select the chain from the top line. Additionally, ensure that you
see a green arrow on the chain you selected. If you see a red arrow, then the chain is
not closed and youwill not be able to extrude the chain.

4. ClickOK in the Chaining dialog box.

The Solid Extrude function panel displays.

5. Right-click in the graphics window and select Isometric (WCS).

6. Press [Alt+S] to shade the part.
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7. Enter the following parameters:

a. Enter Phone Slot for Name.

b. Ensure thatMethod is set to Cut body.

c. Set Distance to 1.25.

NOTE
Ensure that the direction chain is pointing up. Select Reverse All if it is not.

8. ClickOK in the Solid Extrude function panel.
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9. Save your file.

Exercise 12: Adding Fillets to Part Edges
In this exercise, you will add fillets to the outside edges of the part.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select Constant Fillet from the Solids tab.

The Solid Selection dialog box displays.
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3. Ensure that the Edge button is selected. Click any other highlighted button to clear that selection
filter.

Only the Edge button will be highlighted.

4. Press [Alt+S] to display the part only as wireframe.

5. Select the following edges.

6. ClickOK in the Solid Selection dialog box.

The Constant Radius Fillet function panel displays.

7. Press [Alt+S] to shade the part.
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8. Set the following parameters:

a. Enter Outside Fillet for Name.

b. Enter 0.1 for Radius.

9. ClickOK in the Constant Radius Fillet function panel.

10. Save your file.
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SHOW US WHAT YOU LEARNED!
Can you answer these questions?

1. When using the Mirror function, which of the following is not used as amirror axis?

a. Single point

b. X axis

c. Angle

d. Vector

2. When creating horizontal lines using the Line Endpoints function, you can create a line with a
specific angle.

a. True

b. False

3. When chaining geometry to extrude as a solid, the chained geometry must be flat and closed.

a. True

b. False

4. The Z Depth setting sets the depth of the current construction plane.

a. True

b. False

5. You can only create fillets with wireframe.

a. True

b. False

6. Which of the following is a type of shape you can create with the Rectangular Shapes function?

a. Ellipse

b. Obround

c. Rhombus

d. Polygon

7. What are the differences between the Trim to Entities and the Divide functions?
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CHAPTER 2

PROGRAMMING THE INDEX HOLES
In this chapter, you set up the stock to be machined. Then, you create the Circle Mill toolpath that will
be used tomill the two index holes.

Goals

l Set up the stock.

l ProgramaCircle Mill toolpath.

l Explore tool libraries including filter by tool type.

l Experiment with toolpath verification usingMastercam Simulator.

CAUTION
When programming toolpaths, only change the values of the indicated parameters. Leave
unmentioned values at their default values.

Exercise 1: Setting Up the Stock
In this exercise, you choose amachine definition and set up your stock.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. If necessary, right-click in the graphics window and select Fit. Then, select Isometric (WCS).
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3. Select Router, Default on theMachine tab.

4. Select the Toolpaths tab to bring the ToolpathsManager to the forefront.

5. Expand the Properties group and select Stock setup. Note that theMachine Group-1 is the
Router Default.

TheMachine Group Properties dialog box displays.

6. Set the following parameters:

CAUTION
These valuesmay vary depending on your machine andmaterial. Make sure to
measure your materials andmodify these values, as necessary!

a. Select Display.

b. Enter 8.0 for Y.

c. Enter 24.0 for X.

d. Enter 1.26 for Z.

e. In Stock Origin, enter -2.0 for X and -0.25 for Y.
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f. Set the stock to the bottom left origin.

7. ClickOK in theMachine Group Properties dialog box.

8. Save your file.
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Exercise 2: Creating the Circle Mill Toolpath
In this exercise, you will create the Circle Mill toolpath that will machine the two index holes created in
the previous chapter.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select the Router Toolpaths contextual tab.

3. Select Circle Mill from the 2D gallery drop-down.

The Toolpath Hole Definition function panel displays.

4. Select the bottomarc of the two index holes.

Youmay need to zoom in and rotate the part to select the correct geometry.

5. ClickOK in the Toolpath Hole Definition function panel.

The 2D Toolpaths - Circle Mill dialog box displays.
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6. Select the Tool page.

7. Click Select library tool.

The Tool Selection dialog box displays.

8. Select Filter.

The Tool List Filter dialog box displays.
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9. SelectNone to remove all tool filters, and then select Endmill1 Flat.

10. ClickOK in the Tool List Filter dialog box.

11. In the Tool Selection dialog box, select 3/8 STRAIGHT BIT and clickOK to return to the Tool
page.
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12. You will receive a tool settingsmodified warning. Thismessage informs you that the tool values
have beenmodified to fit your current machine and control definitions. ClickOK to accept the
changes.

13. In the Tool page, enter 50.0 for Feed rate and Plunge rate.

CAUTION
These valuesmay vary depending on your machine andmaterial.

14. Select the Cut Parameters page.

15. Set the following parameters:

a. Set Compensation direction to Right.
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b. Enter 0.00 for Stock to leave on walls and Stock to leave on floors.

16. Select the Roughing page.

17. Set the following parameters:

a. Select Roughing.

b. Enter 50.0% for Stepover.

c. Enter 2.0% forMinimum radius.

d. Enter 10.0% forMaximum radius.

e. Enter 3.0 for Plunge angle.

18. Select the Finishing page.
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19. Set the following parameters:

a. Select Finishing.

b. Ensure that Finish is selected.

c. Ensure that 1.0 is entered for Number.

d. Enter 0.002 for Spacing.

e. Set Finish passes to Final depth.

20. Select the Linking Parameters page.

21. Set the following parameters:

a. Set Retract, Feed plane, and Top of stock to Absolute.

b. Enter 2.0 for Retract.

c. Enter 1.4 for Feed plane.

d. Enter 1.26 for Top of stock.
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e. Ensure that Depth is set to Incremental and has a value of 0.0.

22. ClickOK in the 2D Toolpaths - Circle Mill dialog box.

23. Save your file.
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Exercise 3: Verifying the Circle Mill Toolpath
In this exercise, you use Mastercam Simulator to view and verify the Circle Mill toolpath.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. In the ToolpathsManager, select Toolpath Group-1.

3. Select Verify selected operations from the ToolpathsManager toolbar.

Mastercam Simulator displays.

Quick Part Series - Acoustic Amplifier—2: Programming the Index Holes



4. Select the Visibility checkboxes on the Home tab to experiment with what displays in the
graphics window.

5. Use the playback bar to run the verification.

The verification shows the milling of the two index holes.

6. Run the simulation a few times and experiment with the Visibility options to see the results.

7. Select the View tab.

8. Ensure that theMove List button is highlighted. If not, click the button to enable the Move List
pane.
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9. Review the Move List pane to display information about the section of the current toolpath in
verification, such as Total Time.

The totalmachining time of the Circle Mill toolpath is short.

NOTE
Your Total Timemay vary.

10. Exit Mastercam Simulator once you have finished viewing the verification.

11. Save your file.

Quick Part Series - Acoustic Amplifier—2: Programming the Index Holes



SHOW US WHAT YOU LEARNED!
Can you answer these questions?

1. The Stock origin can be located at a different location other than the machine origin.

a. True

b. False

2. Youmust enter the size of the stockmanually.

a. True

b. False

3. You can display the stock in the graphics window to view the orientation and the location of the
part relative to stock.

a. True

b. False

4. Verify gives you the chance to view toolmotion withmaterial removal.

a. True

b. False

5. InMastercam Simulator, you can limit the objects you see on-screen, such as toolpaths, tools,
stock, or fixtures.

a. True

b. False

6. Mastercam Simulator reports how long it will take to machine a toolpath.

a. True

b. False

7. Whenmachining this part, why would you choose a Circle Mill toolpath instead of a Drill toolpath
to machine the index holes?

8. What are the benefits of using simulation to review toolpaths?
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CHAPTER 3

PROGRAMMING THE AMPLIFIER CHANNEL
In this chapter, you create the DynamicMill toolpath that will machine the amplifier channel created in
Chapter 1. You then use Mastercam Simulator to verify the created toolpath.

Goals

l ProgramaDynamicMill toolpath.

l Explore the Preview chain function.

CAUTION
When programming toolpaths, only change the values of the indicated parameters. Leave
unmentioned values at their default values.

Exercise 1: Creating the Dynamic Mill Toolpath
In this exercise, you will create the DynamicMill toolpath.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. ClickOnly display selected toolpaths in the ToolpathsManager.

By selecting this button, only toolpaths that you have selected in the ToolpathsManager will
display in the graphics window.

3. Select the Router Toolpaths contextual tab.
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4. Select Dynamic Mill from the 2D gallery drop-down.

The Chain Options dialog box displays.

5. Click Select machining chains to return to the graphics window to select the machining
regions.

The Chaining dialog box displays.

6. Select Solids to set the chainingmode to solids.

7. Ensure that the Selection Method is set only to Face. Click any selectionmethod button to
remove that selection filter.
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8. Select the bottom solid face of the channel as shown below.

9. ClickOK in the Chaining dialog box to return to the Chain Options dialog box.

10. In the Chain Options dialog box, setMachining region strategy to From outside.

11. Click Select avoidance chains to return to the graphics window to select the avoidance regions.

The Chaining dialog box displays.
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12. Select the two top solid faces as shown below.

13. ClickOK in the Chaining dialog box and then clickOK again in the Chain Options dialog box.

The 2D High Speed Toolpaths - Dynamic Mill dialog box displays.

14. Select the Tool page.

15. Select the 3/8 STRAIGHT BIT tool from the tool list.

16. You will receive a tool settingsmodified warning. Thismessage informs you that the tool values
have beenmodified to fit your current machine and control definitions. ClickOK to accept the
changes.
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17. Select the following parameters on the Tool page:

a. Select RCTF.

b. Enter 100.00 for Plunge rate.

18. Select the Cut Parameters page.

19. Set the following parameters:

a. Enter 300.00 for Back feedrate.

b. Enter 0.0 for Stock to leave on walls and Stock to leave on floors.

20. Select the Linking Parameters page.

21. Set the following parameters:

a. Set Retract, Feed plane, and Top of stock to Absolute.

b. Enter 2.0 for Retract.

c. Enter 1.4 for Feed plane.

d. Enter 1.26 for Top of stock.
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e. Ensure that Depth is set to 0.0 and Incremental.

22. Select the Toolpath Type page.

23. Select the Preview chains button.
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24. Your part displays as shown below in the graphics window.

This allows you to ensure that you have selected the correct chain geometry and you are
machining the correct areas.

25. ClickOK in the 2D High Speed Toolpaths - Dynamic Mill dialog box.

26. Rotate the part to view the toolpath. You can also press [Alt+S] to display the part as wireframe.

27. Save your file.
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Exercise 2: Verifying the Dynamic Mill and Circle Mill Toolpaths
In this exercise, you use Mastercam Simulator to view and verify the Circle Mill and DynamicMill
toolpaths.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. In the ToolpathsManager, select Toolpath Group-1.

3. Select Verify selected operations from the ToolpathsManager toolbar.

Mastercam Simulator displays.
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4. Use the playback bar to run the verification.

The verification shows the machining of the channel geometry and the drilling of the index holes.

NOTE
Youmay see extramaterial at the entrance of one channel of the amplifier
geometry. This is because of the extra stock we added to the Y axis whenwe created
the stock origin. entered in the Stock Origin of the Stock Setup tab. We will address
this extramaterial in a later chapter.

Rotate the part or select Top view to see that the extramaterial is outside the
machining region.
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5. Exit Mastercam Simulator once you have finished viewing the verification.

6. Save your file.
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SHOW US WHAT YOU LEARNED!
Can you answer these questions?

1. Youmust chain toolpath geometry for DynamicMill one entity at a time.

a. True

b. False

2. What are the differences between the twomachining strategies, From outside and Stay
inside?

3. When creating aDynamicMill toolpath, which of the following Chain geometry types is not
considered?

a. Machining regions

b. Check regions

c. Containment regions

d. Air regions

4. Absolute values for linking parameters (such as Clearance and Retract) are alwaysmeasured
from the origin (0,0,0) of the current WCS.

a. True

b. False

5. What are the benefits of using Preview chains in the Dynamic Mill toolpath?
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CHAPTER 4

PROGRAMMING THE CELL PHONE OPENING
In this chapter, you create DynamicMill and Contour toolpaths to machine the cell phone opening
created in Chapter 1. You then use Classic Backplot to simulate the toolpath, as well as use Section
Views to help view the simulation.

Goals

l ProgramaDynamicMill and 2D Contour toolpath.

l Explore Classic Backplot.

l Explore using section views to cut away the part to see interior geometry and features.

CAUTION
When programming toolpaths, only change the values of the indicated parameters. Leave
unmentioned values at their default values.

Exercise 1: Creating the Dynamic Mill Toolpath
In this exercise, you will create the DynamicMill toolpath.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select the Router Toolpaths contextual tab.

3. Select Dynamic Mill from the 2D gallery drop-down.

The Chain Options dialog box displays.
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4. Click Select machining chains to return to the graphics window to select the machining
regions.

The Chaining dialog box displays.

5. SelectWireframe to set the chainingmode to wireframe.

6. Right-click in the graphics window and select Top (WCS).

7. Select the phone slot geometry as shown below.

8. ClickOK in the Chaining dialog box to return to the Chain Options dialog box.
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9. SetMachining region strategy to Stay inside.

10. ClickOK in the Chain Options dialog box.

The 2D High Speed Toolpath - Dynamic Mill dialog box displays.

11. Select the Tool page.

12. Select the 3/8 STRAIGHT BIT tool from the tool list.

13. You will receive a tool settingsmodified warning. Thismessage informs you that the tool values
have beenmodified to fit your current machine and control definitions. ClickOK to accept the
changes.

14. Select the Cut Parameters page.
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15. Enter 0.01 for Stock to leave on walls.

16. Select the Linking Parameters page.

17. Enter the following parameters:

a. Ensure that Retract is set to 2.0 and Absolute.

b. Enter 0.2 for Feed plane and set to Incremental.

c. Enter 0.26 for Top of stock and set to Absolute.

d. Ensure that Depth is set to 0.0 and set to Absolute.

18. ClickOK in the 2D High Speed Toolpath - Dynamic Mill dialog box.
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19. Right-click in the graphics window and select Isometric (WCS).

20. Press [Alt+S] to view the part as wireframe.

This allows you to view the toolpath you have just created.

21. After you have viewed your toolpath, press [Alt+S] again to shade the part.

22. Save your file.

Exercise 2: Creating the Contour Toolpath
In this exercise, you will create a Contour (Ramp) toolpath.
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1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select the Router Toolpaths contextual tab.

3. Select Contour from the 2D gallery drop-down.

The Chaining dialog box displays.

4. Right-click in the graphics window and select Top (WCS).
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5. Select the phone slot geometry as shown below. It may be helpful to unshade the part.

Ensure that your chain direction (the green arrow) and the start point matches the chain shown
previously. If not, use the Reverse button on the Chaining dialog box to change the direction of
the chain.

6. ClickOK in the Chaining dialog box.

The 2D Toolpaths - Contour dialog box displays.

7. Select the Tool page.

8. Select the 3/8 STRAIGHT BIT tool from the tool list.
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9. You will receive a tool settingsmodified warning. Thismessage informs you that the tool values
have beenmodified to fit your current machine and control definitions. ClickOK to accept the
changes.

10. Select the Cut Parameters page.

11. Enter the following parameters:

a. Ensure that Compensation direction is set to Left.

b. Set Contour type to Ramp.

c. Enter 25.0 for Ramp angle.
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12. Select the Break Through page.

WARNING
Enter a break through amount only if your set-up includes a spoilboard. You risk
damaging your equipment (tool damage, cutting into your table, etc.) if you create a
break throughwithout a spoilboard!

13. Enter the following parameters:

a. Select Break through.

b. Enter 0.01 for Break through amount.

14. Select the Linking Parameters page.

15. Enter the following parameters:

a. Enter 2.0 for Retract and set to Absolute.

b. Enter 0.2 for Feed plane and set to Incremental.

c. Enter 0.26 for Top of stock and set to Absolute.
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d. Ensure that Depth is set to 0.0 and Absolute.

16. ClickOK.

17. Right-click in the graphics window and select Isometric (WCS).
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18. Press [Alt+S] to view the part as wireframe.

19. After you have viewed your toolpath, press [Alt+S] again to shade the part.

20. Save your file.

Exercise 3: Creating the Section View
In this exercise, you will create a section view that you use during simulation to help get a better view of
the machining.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select the Planes tab to bring the PlanesManager to the forefront.
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3. Ensure that the Section column is displayed.

If is it not, right-click on the columns and select Section.

4. Select Create new plane, From entity normal.

This newplane will be the basis for the section view.
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5. Select the line entity as shown below.

6. Use the Select plane dialog box buttons to find the plane that is shown below.

7. ClickOK.

The New Plane function panel displays.

8. Enter Cutting View for Name and clickOK.
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9. In the PlanesManager, click in the Section column for the Cutting View plane you just created.

10. Then, click Section View on the PlanesManger toolbar.

NOTE
The Section View button and drop-down is also on the View tab.

11. The part then displays as shown below.
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12. In the Section View drop-downmenu, deselect Toolpaths and select Show Caps.

By deselecting Toolpaths, the toolpaths are not cut by the section view. Show Caps fills in
sections of the part with a solid cap.

13. Save your file.
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Exercise 4: Backplotting the Toolpaths
In this exercise, you will use Classic Backplot to simulate the DynamicMill and Contour toolpaths created
in the previous exercises and use the section view to easily view the motion.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select the Toolpaths tab to bring the ToolpathsManager to the forefront.

3. In the ToolpathsManager, hold down [Ctlr] and select 3 - 2D High Speed (2D Dynamic Mill)
and 4 - Contour (Ramp).
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4. Both toolpaths are displayed in the graphics window and you can see them clearly due to the
section view created in the previous exercise.

5. Select Backplot selected operations from the ToolpathsManager toolbar.

The Backplot dialog box and playback bar display.

6. Press Play in the playback bar to begin the simulation.
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7. Press Stop about halfway through the simulation.

8. Select the View tab.

9. Select Section View to toggle section views off.
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10. You can no longer see the toolpath simulation clearly in the graphics window. By creating and
using section views, you are easily able to see the interior of a part.

11. Select Section View to toggle section views on.

12. Return to the Backplot dialog box. This dialog box includes several visibility options, similar to the
options withinMastercam Simulator.
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13. Experiment with the options and continue running the simulation. You can also rotate the part in
the graphics window view the simulation.

14. Once you are satisfied with the simulation, clickOK in the Backplot dialog box.

15. On the View tab, select Section View again to toggle section views off.

16. Return your part to Isometric view if necessary.

17. Save your part.
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SHOW US WHAT YOU LEARNED!
Can you answer these questions?

1. Which of the following is not aContour type you can select for a 2D Contour toolpath?

a. 2D

b. Ramp

c. 3D

d. Dynamic

2. What are the benefits of using the Section View function?

3. You can control visibility options (such as tool visibility) when using Classic Backplot.

a. True

b. False

4. What is the purpose of the Break through option for 2D Contour toolpaths?

5. Which of the following is not an entity you can turn off sectioning for?

a. Stock Models

b. Toolpaths

c. Wireframe Entities

d. Unshaded entities
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CHAPTER 5

PROGRAMMING THE TABS
In this chapter, you use the Curve All Edges function to create wireframe to support the filleted
edges of the part. Then, you create tab points and a Contour toolpath to machine those points as tabs.

Tabs are uncut areas of a toolpath that assist in holding down a part. While the tool is cutting the
contour, it retracts slightly at the tab location to leave a small amount of stock, then plunges back to
the normal cutting depth. Tabs are especially useful when you are cutting out small parts, multiple
parts, or nested parts.

Refer to the "Using Tabs" Help topic inMastercam for more information.

Goals

l Understanding the creation and use of tabs.

l Explore and use the Curve All Edges function.

l Explore the LevelsManager.

l ProgramaContour toolpath.

CAUTION
When programming toolpaths, only change the values of the indicated parameters. Leave
unmentioned values at their default values.

Exercise 1: Creating the Support Geometry
In this exercise, you will create tab geometry based on the solidmodel. Later in this chapter, you will
use this geometry to programaContour toolpath.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select the Levels tab to bring the LevelsManager to the forefront.
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3. In the Number parameter of the LevelsManager, enter 15 and press [Enter].

There is now a new level in the LevelsManager. By default, the new level becomes your main
level.

4. Enter Solid Extrude Profile for Name.

5. In the graphics window, hold [Shift] and select the rectangle wireframe as shown below.

6. Right-click in the graphics window and select Change level from the mini-toolbar.

The Change Levels dialog box displays.
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7. Ensure that Operation is set toMove andUse Active Level is selected.

8. ClickOK.

The wireframe entities have moved from Level 1 to Level 15.

9. In the LevelsManager, click in the Number column for Level 1 to set it as the main level.
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10. Click in the Visible column for Level 15 to clear the X and hide the entities from the graphics
window.

11. In the Status Bar, click the value next to Z and enter 0.0. Press [Enter] to apply the value.

12. Select Curve All Edges on theWireframe tab.
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13. Right-click in the graphics window and select Gview, Bottom (WCS).

14. Select the bottom face of the solid body and press [Enter].

The Curve On All Edges function panel is now active.

15. ClickOK in the Curve On All Edges function panel.
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16. Right-click in the graphics window and select Isometric (WCS).

17. Use the middle mouse wheel to zoom into a corner of the solid part.

Curve On All Edges creates wireframe geometry based on the edges of the solid face, including
the fillets.
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18. Right-click in the graphics window and select Fit.

19. Save your part.
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Exercise 2: Creating the Tab Points
In this exercise, you will create points on the wireframe geometry created in the previous exercise.
The points will be used by a Contour toolpath to automatically create tabs. The tabs will be used to help
secure the part to the table duringmachining.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select Point Position on theWireframe tab.

The Point Position function panel displays.

3. Select the midpoint of the three wireframe lines created in the previous exercise. You do not
need to create a point on the front of the part.

You will need to rotate the part or unshade the part to select the midpoint of the three lines.

4. ClickOK in the Point Position function panel.

5. If necessary, return your part to Isometric view.
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6. Click the Select all point entities Quick Mask. All point entities are then selected in the graphics
window.

7. Right-click in the graphics window and select the square point style from the Point Style drop-
down.

The point entities nowdisplay as squares.

8. Save your file.
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Exercise 3: Creating the Contour Toolpath
In this exercise, you will create a Contour toolpath that will machine the outside walls of the part. The
Contour toolpath will automatically create tabs based on the square points created in the previous
exercise.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. Select the Toolpaths tab to bring the ToolpathsManager to the forefront.

3. Select the Router Toolpaths contextual tab.

4. Select Contour from the 2D gallery drop-down.

The Chaining dialog box displays.

5. If necessary, selectWireframe to set the chainingmode to wireframe.
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6. Select the wireframe rectangle as shown below. Ensure you are selecting in the area pointed out
below.

Ensure that your chain direction (the green arrow) matches the chain direction above. If not, use
the Reverse button on the Chaining dialog box to change the direction of the chain.

7. ClickOK in the Chaining dialog box.

The 2D Toolpaths - Contour dialog box displays.

8. Select the Tool page.

9. Select the 3/8 STRAIGHT BIT tool from the tool list.
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10. You will receive a tool settingsmodified warning. Thismessage informs you that the tool values
have beenmodified to fit your current machine and control definitions. ClickOK to accept the
changes.

11. Select the Cut Parameters page.

12. Set Contour type to 2D.

13. Select the Depth Cuts page.
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14. Enter the following parameters:

a. Select Depth cuts.

b. Enter 0.3 forMaximum rough step.

c. Select Keep tool down.

15. Select the Lead in/Out page.

16. Enter the following parameters:

a. Enter 25.0 for Length.

b. Enter 50.0 for Radius.

c. Click the Copy button to copy these values from the Entry section to the Exit section.
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17. Select theMulti Passes page.

18. Enter the following parameters:

a. SelectMulti Passes.

b. Enter 0.02 for Spacing in both the Rough and Finish group.

c. Enter 1.0 for Number under Finish.

d. Set Finish passes to Final depth.

19. Select the Tabs page.
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20. Enter the following parameters:

a. Select Tabs.

b. Ensure Tab Position is set toManual.

c. Select Use square point for tab position.

d. Enter 0.1 for Tab thickness.

21. Select the Linking Parameters page.

22. Enter 1.4 for Feed plane and set to Absolute.

23. ClickOK in the 2D Toolpaths - Contour dialog box.
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24. Save your file.

Exercise 4: Verifying All the Toolpaths
In this exercise, you use Mastercam Simulator to view and verify all of the created toolpaths so far.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. In the ToolpathsManager, select Toolpath Group - 1.
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3. Select Verify selected operations from the ToolpathsManager toolbar.

Mastercam Simulator displays.
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4. Use the playback bar to run the verification.

The verification shows the machining of the entire part.

5. Select the Verify contextual tab inMastercam Simulator.
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6. Select Color Loop.

The part then changes colors in the Mastercam Simulator graphics window. Color Loop changes
the color of the cut stock by operation or tool.
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7. Right-click inMastercam Simulator's graphics window and select Top (WCS).

You can now see the tabs created by the Contour toolpathmade in the previous exercise.

8. Exit Mastercam Simulator once you have finished viewing the verification.

9. Save your file.
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SHOW US WHAT YOU LEARNED!
Can you answer these questions?

1. Tabs are uncut areas of a toolpath that assist in holding down a part.

a. True

b. False

2. Depth cuts are used to divide the total depth into separate Y axis cuts to avoid plunging the tool
directly into material.

a. True

b. False

3. The Color Loop function inMastercam Simulator changes the color of the cut stock only by tool
type.

a. True

b. False

4. Which of the following is aQuick Mask selection type?

a. Points

b. Lines

c. Solids

d. Arcs

e. All

f. None

5. What is the differences betweenmulti passes and depth cuts?
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CHAPTER 6

DUPLICATING THE MODEL AND EDITING THE
TOOLPATHS

In this chapter, you use the Transform function to create a second solidmodel to serve as the bottom
part of the acoustic amplifier. You then use various functions in the ToolpathsManager to duplicate
the toolpaths and re-chain the geometry.

Goals

l Explore various functions of the ToolpathsManager.

l Use the Transform function to copy andmove the solidmodel.

Exercise 1: Copying and Modifying Toolpath Groups
In this exercise, you will duplicate the toolpath group in the ToolpathsManager. You will also remove
toolpaths that will not be needed tomachine the second solidmodel.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. If necessary, select the Toolpaths tab to bring the ToolpathsManager to the forefront.

3. Right-click Toolpath Group-1 and select Groups, Rename from the menu.

NOTE
You can also triple left-click Toolpath Group-1 to change the name.
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4. Type Top and press [Enter].

5. Right-click the Top toolpath group and drag your mouse to the bottomof the Toolpaths
Manager.
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6. Release the mouse and select Copy after from the pop-upmenu.

There will nowbe a new Toolpath Group-1 displayed in the ToolpathsManager.

7. Rename Toolpath Group-1 to Bottom.

8. Select 8 - 2D High Speed (2D Dynamic Mill) in the ToolpathsManager.
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9. Right-click 8 - 2D High Speed (2D Dynamic Mill) and select Delete from the menu. This
toolpath is used tomachine the phone slot.

10. A warning dialog box displays. Click Yes to proceed with the deletion.
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11. Select and delete 8 - Contour (Ramp) toolpath. The ToolpathsManager shouldmatch the image
shown below.

12. Save your file.
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Exercise 2: Translating the Solid Model
In this exercise, you will use Translate to duplicate the solidmodel andmove it to a specific location.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. In the ToolpathsManager, selectMachine Group - 1.

This selects both the Top and Bottom toolpath groups.

3. Select Toggle display on selected toolpaths operations to hide the toolpaths in the graphics
window.

4. Select Translate on the Transform tab.
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5. Left-click in the graphics window and drag your mouse over the entire solidmodel and
wireframe.

6. Release the mouse to select the geometry.

7. Press [Enter].

The Translate function panel is now active.
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8. Ensure thatMethod is set to Copy and enter 10.0 for Delta X.

9. ClickOK in the Translate function panel.

The part is copied and pasted in the location you entered.

10. Right-click in the graphics window and select Clear Colors.

11. Save your file.
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Exercise 3: Re-chaining the Toolpaths
In this exercise, you will re-chain the toolpaths in the Bottom toolpath group from the original part to
the translated part. The copied toolpaths are still referencing geometry from the original solidmodel.
The toolpaths need to be updated to use the geometry on the copied solidmodel instead.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. If necessary, select the Toolpaths tab to bring the ToolpathsManager to the forefront.

3. In the Bottom toolpath group, select Geometry under 6 - Circle Mill in the ToolpathsManager.

The Toolpath Hole Definition function panel displays.

4. Select a solid arc in the Features list.

You can see that the toolpath is referencing geometry from the original solidmodel.
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5. Right-click in the Features list and select Delete all from the menu.

6. Select the bottomarc of the two index holes on the new solidmodel that was created in the
previous exercise.

Youmay need to zoom in and rotate the part to select the correct geometry.

7. ClickOK in the Toolpath Hole Definition function panel.

The Circle Mill toolpath is nowmarked dirty in the ToolpathsManager.
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8. Select Regenerate all dirty toolpaths in the ToolpathsManager toolbar.

The Circle Mill toolpath regenerates and displays as shown below on the translated solidmodel.

9. Select Geometry under 7 - 2D High Speed (2D Dynamic Mill) in the ToolpathsManager.

The Chain Options dialog box displays.
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10. Click Remove selected machining chains underMachining regions.

The selectedmachining region is removed.

11. Click Select machining chains to return to the graphics window to select the machining
regions.

The Chaining dialog box displays.

12. If necessary, select Solids to set the chainingmode to solids.

13. Ensure that the Selection Method is set only to Face. Click any active selectionmethod button
to remove that selection filter.
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14. Select the bottom solid face of the channel on the translated solidmodel as shown below.

15. ClickOK in the Chaining dialog box to return to the Chain Options dialog box.

16. Click Remove selected avoidance chains under Avoidance regions.

The selectedmachining region is removed.

17. Click Select avoidance chains to return to the graphics window to select the avoidance regions.

The Chaining dialog box displays.
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18. Select the two top solid faces on the translated solidmodel as shown below.

19. ClickOK in the Chaining dialog box, and then clickOK again in the Chain Options dialog box.

20. Select Geometry under 8 - Contour (2D) in the ToolpathsManager.

The Chain Manager dialog box displays.
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21. Right-click in the Chain list and select Rechain all from the menu.

The Chaining dialog box displays.

22. SelectWireframe to set the chainingmode to wireframe.
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23. Select the wireframe rectangle as shown below.

Ensure that your chain direction (the green arrow) matches the chain direction above. If not, use
the Reverse button on the Chaining dialog box to change the direction of the chain.

24. ClickOK in the Chaining dialog box. Then, clickOK in the Chain Manager dialog box.
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25. Select Parameters under 8 - Contour (2D) in the ToolpathsManager.

The 2D Toolpaths - Contour dialog box displays.

26. Select the Tabs page.

27. Deselect Use square point for tab position.

28. Select Position to return to the graphics window to select the tab positions.
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29. Select the wireframe on the translated part as shown below.

30. Place the tab by left-clicking at the midpoint of the line.

NOTE
When positioning the tabs, they will not "snap" to the square point created in the
previous chapter. You need tomanually place the tab.

31. Repeat the previous two steps with the other wireframe lines around the translated part. You
will have three tabs when finished.

150

Quick Part Series - Acoustic Amplifier—6: Duplicating the Model and Editing the Toolpaths



151

32. Press [Enter] after you have placed the tabs to return to the 2D Toolpaths - Contour dialog
box.

33. ClickOK in the 2D Toolpaths - Contour dialog box.

34. Select Regenerate all dirty toolpaths in the ToolpathsManager toolbar.

35. In the ToolpathsManager, select the Bottom toolpath group.

The part displays with the updated toolpaths.

36. Save your file.
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Exercise 4: Verifying All Toolpaths
In this exercise, you will verify all of the toolpaths created in previous exercises and chapters.

1. Your file Amplifier-XXX which you saved from the previous exercise should be open inMastercam.

2. In the ToolpathsManager, selectMachine Group - 1.

This selects both the Top and Bottom toolpath groups.
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3. Select Verify selected operations from the ToolpathsManager toolbar.

Mastercam Simulator displays.
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4. Use the playback bar to run the verification.

The verification shows the machining of both parts.

5. Experiment with the available options on the Home, View, and Verify tabs of Mastercam
Simulator.

6. Exit Mastercam Simulator once you have finished viewing the verification.

7. Save your file.
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SHOW US WHAT YOU LEARNED!
Can you answer these questions?

1. If a toolpath needs to be edited after creation, it must be deleted and re-created.

a. True

b. False

2. The Translate function will only move, copy, or join wireframe geometry.

a. True

b. False

3. What is the benefit of havingmultiple toolpath groups in one machine group?

4. Describe amethod you can employ to reuse a toolpath.
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CHAPTER 7

FIXTURING THE STOCK
Selection of the proper fixture is important to successfulmachining. The choice of fixture involves
consideration of the size of the piece you are machining, and the ability to machine around the
exterior and the interior of the piece successfully, while avoiding the fixture itself.

For this tutorial, we recommend that you use a vacuum table. Additionally, the tabs created in the
previous chapters will help to hold the part in place. However, if your machining environment does not
include a vacuum table, this chapter will also briefly discuss other means of holding down parts when
machining using a router.

Goals

l Explore and learn about different ways to hold down the stock.

Fixture options
l Vacuum table. A vacuum table is a system that uses air pressure to hold the stock and
workpieces to the router, keeping them still duringmachining. (recommended)

A vacuum table will allow full access to all sides of your part, except the side that is in contact with
the table's surface. However, the security of the part is relative to the amount of surface area
that is in contact with the vacuum. In other words, the smaller the part, the more difficult it is for
a vacuum table to hold it in place.

l Screwing down the stock. You can use screws to hold down the stock. This option requires a
spoilboard. The location of the screws need to be considered whenmachining.

A spoilboard is a disposable work surface mounted atop the router’s permanent table.

l Double-sided tape. You can use double-sided tape to keep the stock connected to the router.
If you choose this option, we recommend that you use double-sided carpet tape.

l Low profile clamps. You can use low profile clamps to hold down the stock. Lowprofile clamps
that take up very little space, which is ideal for a router. The location of the clamps need to be
considered whenmachining.

157



SHOW US WHAT YOU LEARNED!
Can you answer these questions?

1. What should be considered if you are using a vacuum table to hold a very small part?

2. When preparing a part to be machined with a router, what is the main benefit of using a vacuum
table over hold-down clamps?
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CHAPTER 8

POST PROCESSING
Post processing, or posting, refers to the process by which the toolpaths in your part file are
converted to a format that can be understood by your machine tool's control (for example, G-codes). A
program called a post processor, or post, reads your part file and writes the appropriate NC code.
Generally, every machine tool or control requires its own post processor, customized to produce code
formatted to meet its exact requirements.

In this chapter you will explore post processing using the default machine chosen for this project. If
you use a different machine, it will require a different post.

Goals

l Understand post processing concepts

l Explore Code Expert and the NC code

Exercise 1: Post Processing the Operations
In this exercise, you will send the completed file to post processor. The post processor creates a
machine-readable NC program from the Mastercam file.

1. Your file, Amplifier-XXX, which you saved from the previous lesson should be open inMastercam.

2. Verify that all of the toolpaths are selected in ToolpathsManager.
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3. ClickG1 to post the toolpaths for the selected operations. The post processor creates amachine-
readable NC program from the Mastercam file.

The Post processing dialog box displays. The name of the post processor for the machine you
have chosen displays as the Active post field in read-only mode.

4. ClickOK. The Save As dialog box opens.
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5. Name your NC file and click Save.

The file opens inMastercamCode Expert.

6. Use the Code Expert controls to explore the NC code.

CAUTION
Customizing the post file is an advanced task that should only be attempted
by knowledgeable users. Programs created with incorrect posts can cause your
machine tool to crash or behave in unpredictable ways.

NOTE
Click the help icon in the upper corner of MastercamCode Expert to learnmore
about the program
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SHOW US WHAT YOU LEARNED!
Can you answer these questions?

1. The post processor creates amachine-readable NC program from the Mastercam file.

a. True

b. False

2. Youmust post all of the operations in the ToolpathsManager.

a. True

b. False

3. Posted NC programs consist mainly of X, Y, and Z values that represent point locations in the CNC
machine.

a. True

b. False

4. Describe how you transfer the information in your Mastercam file to your machine?
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CHAPTER 9

CHALLENGE: SELF-GUIDED PROJECT
Now that you have a basic understanding of designing and programming inMastercam, it is time to
design and customize a part of your own. For this self-guided project, you will design a phone charging
station inMastercam.

Suggestion 1: Charging Station
l Design your phone charging station to include a recess for awireless charging pad, a slot for the
charging cable and an area to holdmoney or keys.

l Consider the dimensions of your phone, and the location of the charging connection on the
phone.

163



Suggestion 2: Charging Station with Viewing Mount
l Design your charging station with a slot to hold the phone to watchmovies or videos.

l Consider the dimensions of your phone, and the depth of the slot needed to hold the phone at a
good viewing angle.

Successful completion of this self-guided project will demonstrate the following skills in Mastercam:

l UsingMastercam's wireframe and solidmodel design tools to create amachinable, solidmodel.

l Programming a part using a variety of 2D Router toolpaths.

l Securing stock to the machine.

l Confirming toolpath operations withMastercam Simulator (Verify).

As part of this project, you will be expected to prepare a brief presentation. The presentation should
be no longer than five minutes and clearly outline the steps that you have taken to complete the
project, including which ideas you explored, what new technology you learned to facilitate the process,
problems that you experienced and how you overcame them, and how you improved the project from
inception through to the finished product.

This self-guided project will be evaluated against the following categories:

l Creativity – the process and ability to explore and expressmultiple ideas in a unique way.

l Initiative – the ability to overcome projects independently and with a positive attitude.

l Iteration – the ability to develop the product with progressive improvement over time.

l Continued Learning – the ability to attempt new techniques as part of the project.

l Presentation – the ability to articulate and explain the process and project.

Design Tips
l Prove out your design using a scrap piece of wood. You can approximate feeds and speeds if the
scrap piece you use is the same material as your finished product.

l Incorporate the use of tabs into your design to aid in proper fixturing of your workpiece.

l If you have access to a 3D printer, test out your design for form, fit, and function.
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l If your design requires a recess that will hold your phone, begin by machining a slightly
undersized recess, and gradually increase the size of the opening. Test the opening with your
phone while the part is on the machine to determine the best, final size.

l Using a tool with the same radius as the internal corner can cause burnmarks. Choose a tool with
a slightly smaller radius to allow the tool to machine an internal corner without causing burn
marks.

l Use a hand router to round corners for finishing.

l Add felt pads as feet to protect the furniture.
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CONCLUSION
Congratulations! You have completed the Quick Part Series - Acoustic Amplifier! Now that you have
mastered the skills in this tutorial, explore Mastercam's other features and functions.

Youmay be interested in other tutorials that we offer. Mastercam tutorials are being constantly
developed, and we will addmore as we complete them.
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